
 

 

 

 

 

 
Reallusion Developer Series 

Creating and Exporting Characters  
for iClone 
 

By the end of this section you should be able to successfully accomplish the following: 
 

o Understand the important character concepts unique to iClone 
o Effectively create and prepare character geometry to export to iClone 
o Understand how texture and materials are handled on characters 
o Place, scale and skin the RL Bone system to your character meshes 
o Export your character meshes from 3DS Max 
o Import your character meshes into iClone 

 
FOR THE POWER USERS: If you are already a 3DS Max Power user, skip to the end of 
this chapter to the “Check list” section to see what’s required to export your data to 
iClone. 
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I. Summary 
 
This section is broken down into five major parts. The first is “Part 1: Character 
Concepts and Constructs.” This section explains how characters work in iClone and 
elaborates on some special requirements for moving characters to iClone. The second 
part is “Part 2: Character Modeling for iClone.” This section discusses specific 
geometric requirements as well as explores some basic techniques you can use to create 
characters for iClone. The third part is “Part 3: Character Texturing for iClone.” Here 
we discuss the special texture requirements for iClone characters. “Part 4: Character 
Skinning for iClone” covers how to skins your meshes. Finally “Part 5: Exporting and 
Importing.” This section details how to move your character data from 3DS Max to 
iClone. 
 

II. Knowledge and Skills needed 
 
In order to get the most out of iClone software, having the basic fundamental skills in 
3DS Max are strongly recommended. Many different skills are needed to create content 
for different aspects of iClone. For more information on the breadth and depth of those 
skills, please review the “Production Pipeline and Workflow” section.  
 
To create original characters for iClone, besides what is described in the “Pipeline and 
Workflow” section, you will most likely need to know the following: 
 
Modeling skills 

o Basic polygonal modeling skills 
o Sub object vertex editing 
o Named selection sets 
o Aligning 
o Pivot Point Editing 

 
Texturing and Material skills 

o Fundamental material editor operation 
o Creation of original standard materials 
o Creation of texture maps using an external image editing program 
o Assigning materials to sub object selections 
o UVW Mapping (including unwrap UVW) 

 
Rigging and Skin skills 

o Basic understanding of hierarchical bone structures 
o Basic understanding of “interactive IK” within 3DSMax 
o Knowledge of the Skin Modifier and envelop editing and vertex weighting 
o Having anatomical skeletal reference is strongly recommended. (see the end of 

this chapter for some suggested reference material) 
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III. Creating Characters for iClone. 
 

Part 1: IMPORTANT! Character Concepts and Constructs 
Characters are handled in a specific way that is unique to iClone. So before we can build 
any characters for iClone, there are some specific constructs we need to discuss so the 
creation process moves smoothly. 
 
BEFORE YOU BEGIN! Lets understand the difference between a G1 Character and G2 
Character: 
 

o G1 Character: Any character model usedin in iClone 1.5 or earlier. This is 
the original iClone character system and still exists in current versions of 
iClone. 
 

o G2 Character: New Characters added to the G1 family of characters with 
added functionality and features. This Characters only appear in iClone 
2.0 or later. 



Concept #1: There are 5 interchangeable and 1 unchangeable body parts allowed in 
iClone. 
 
As you will see there are only 5 interchangeable body parts in an iClone G1 character. Of 
those parts, only 4 can be created from scratch or edited from an existing model. The 
basic body parts are: 

 Upper body: The upper body contains the torso, arms and hands. 
 Lower body: The Lower body contains the waist and legs, but stop at the 

ankles. 
 Shoes: These are the only objects in this part. 
 Hair: Hair can be one single contiguous mesh, or one mesh made up of 

sub object elements. 
 Face: The face is the only part you don’t explicitly model. This object is 

handled differently and is discussed in the “About the Head Section” 
below. 

 
Figure: The G1 separate body parts. The Hair is not shown in this example.  
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As for the iClone G2 character, you will find 6 interchangeable body parts. Of those parts, 
only 5 can be created from scratch or edited from an existing model. The basic body parts 
are: 

 Upper body: The upper body contains the torso and arms. 
 Lower body: The Lower body contains the waist and legs, but stop at the 

ankles. 
 Shoes: These are the only objects in this part. 
 Hair: Hair can be one single contiguous mesh, or one mesh made up of 

sub object elements. 
 Face: The face is the only part you don’t explicitly model. This object is 

handled differently and is discussed in the “About the Head Section” 
below. 

 Hands: The hand parts are separate from the upper limbs to allow for 
interchangeability in the future. (Please notice that in iClone 2, there is no 
interface for modifying the hands. Therefore, it is not suggested to modify 
the texture of hands.) 

 
Figure: The G2 Separate body parts. The Hair is not shown in this example.  

 

 
 
Note: The body parts among G1 and G2 are not interchangeable since the mesh 
structures and the connection lines are different. “Upper”, “Lower” and “Shoes” are 
included in this category. However, the “Face” and “Hair” are not, which means you 
can apply them, as well as interchange, to G1 or G2 characters as will.  
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Concept #2: Body proportions can be changed in iClone. 
 
Once you get the character model to iClone further adjustment can be made in its 
proportions. iClone can automatically make changes to the geometry based on your input.  
 
The proportion changes are characterized as  “Average”, “Strong”, “Plump”, “Slim”, 
“Cartoon” and “Miniature”. 
 

Figure: These are the different character proportions available in iClone 
 

 
 
Concept #3 : Head models are already in iClone 
 
For Standard characters, head models are already in iClone (Since all the parts are 
interchangeable) so there is no reason to model a head for the standard character. 
 
For the Non-standard character, the interchangeable head model usage in iClone is 
disabled. So you will need to have a head part of your complete mesh. You will still be 
able to adjust the size of the head with iClone’s built in tools. (As well as the size of the 
hands and the feet and the predefined body proportions.) 
 

Creating and Exporting Characters for iClone Page 6  Copyright © 2006 Reallusion, Inc. 
 



Concept #4: Skin tone is determined by the face texture color. 
 
IClone has an automated skin color matching mechanism that will automatically adjust 
the skin tone of the face model to skin tone of the model you create. 
 
The requirements for this are only that the material naming conventions be followed that 
are discussed below, and that there be at least a 10x10 pixel swatch of color that 
represents your average skin tone in the upper left corner of the skin texture bitmap. 
 

Figure: This is an example of the autoskin tone matching system. 
 

 
 

Figure: These Images show how the color tone is chosen. 
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Concept #5: The Bone System is unique to iClone. (Do not use Max bones or 
Character Studio) 
 
The bone system for iClone is not one of the Max’s default bones systems (Max bones or 
biped). iClone comes with its own custom rig that is used for both standard (G1 and G2) 
and non-standard characters (any 3rd party character from any other source. See Part 2 
later in this section.). Since the rig is used for skinning and not for direct animation, it is 
not a fully implemented rig (meaning there are no handles, angle controllers or other 
helpers). 
 
The G2 bone system inherited all the features of G1 bone system, but it is different from 
the G1 bone system because certain bones are separated and other bones are appended for 
sharing the weight for skinning.  

 
Figure: This is the G1 and G2 custom RL bones Rig 

 
 

Figure: G1 and G2 Joint Names 

 
 

Creating and
 

 Exporting Characters for iClone Page 8  Copyright © 2006 Reallusion, Inc. 



Other notable skeletal features: 

1. Please remember that the hand bone structures are identical for G1 and G2 characters. 
Please refer to the illustration below. 

Figure: The hand joint names 

 

2. There are two special abdominal bones for imitating the vibration of the belly when a 
character moves.  

Part 2: Character modeling for iClone 
 
Two different character methods: Standard and Non-Standard Characters 
 
There are 2 types of character models for iClone. You can create a new model that meets 
explicit rules (see below) or edit an existing template— both are considered a Standard 
Character. Or you can create one from scratch or repurpose one from a previous project 
that does not meet the explicit rules—this is called a Non-Standard Character. 

 
 
 

Map Figure: Character Types 
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A Standard Character: 
 
 

Map Figure: Standard Character Creation 

 
 
You can create a character from scratch and it must adhere to specific geometric 
requirements to be considered a standard character. For the purposes of this document we 
will use the template characters provided with iClone. 
 
The reason for using a predefined character template is that the rules associated with their 
geometric structure are already taken care of. All you have to do is edit the character any 
way you would like just taking care not to “break the rules.” One way to create a 
character for iClone is to edit the existing template called: 

 
 Full_template_male.max 
 Full_template_female.max  
 Full_template_G2_male.max 
 Full_template_G2_female.max 
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  Figure:  The G1 male and female template .MAX files. Figure:  The G2 male and female template .MAX files.

 
 
These are called “Standard Characters” because they strictly adhere to the geometric 
conventions described below.  
 
NOTE: At this time, it is not recommended that you deviate from the edge and vertex 
requirements. But feel free to create original characters with these requirements in mind. 
iClone  generates 9 types of base models for use with the set of G2 characters. But only 
the two templates shown above are provided for your character modeling process. 

XorJuniorMay Moe 

Xaria Slade Sarah

 



Before you begin any modeling of characters for iClone, you need to keep in mind the 
special requirements concerning the attachment points for the major body parts. In the 
figure below, you will see the major attachment points are identified.  
 

Creating and
 

  Figure: The Standard G1 Character Attachment points. Figure: The Standard G2 Character Attachment Points

 
 

 
 

The vertex and edge border rules: 
 

Rule #1: There must be a specific number of vertices and edges that make up the 
border between any two body parts. For example, where the neck attaches to the 
“Upper” body, there must be a specific number of vertices on the bottom border 
of the neck, and top of the torso where the neck attaches. 
 

Figure: An example of the required vertices in the neck (G1 and G2) 
 

G1 G2 
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The edge and vertex counts are as follows: 
 
Table: This table shows the locations and vertex/edge counts of the Standard G1 character attachment points.  

 
Connection 

type Neck Waist Ankles 

Border 
Appearance 

  
# of 

Vertices 24 28 12 (each) 

# of Edges 24 28 12 (each) 
 
Table: This table shows the locations and vertex/edge counts of the Standard G2 Character attachment points. 
 

Connection 
type Neck Waist Ankles 

Border 
Appearance 

  

# of 
Vertices 24 28 12 (each) 

# of Edges 24 28 12 (each) 
 

Connection 
type Hand 

Border 
Appearance  

 
# of 

Vertices 12 (each) 

 
# of Edges 12 (each) 
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Rule #2: The vertices must align together. This is fairly simple. Just make sure 
that the vertices from both pieces of geometry align together. It’s OK to move the 
vertices to accomplish this. Just make sure there are equal numbers of vertices (as 
mentioned in Rule #1) 
 
Figure: These two illustrations show examples of aligned vertices in the waist area. All border vertices must 

be aligned. 
G1 G2 

 

Line02 

 
 

 
Rule #3: The vertices must have appropriately named selection sets. Each border 
of vertices is given a specific selection set name at the sub object level. We will 
show you how to do this in the following section.  
 

Figure:  The Sub object selection sets for the border vertices. 
 

 
 
 
 
 
Hair:  
 
Hair for Standard Characters in iClone are treated simply as meshes with their own 
material called “Hair”. When creating hair be sure to use the head template as position 
reference. 
 
 
 
 
 

Table: Examples of hair models 
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Hair made out of 2 (or more) objects Hair made of 1 object 

 
 
NOTE: When creating hair, you must make sure that you align the pivot point of the hair 
object to the head bone in the RL bone structure. This will ensure proper movement of 
your hair in iClone. 
 

1.) Select the Hair object 
 

 
Figure: Hair object selected 

 

 
 

2.) On the hierarchy command panel, choose Pivot>Affect Pivot only 
 

 
 
 
 

Figure: Hierarchy Command panel 
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3.) Choose “Align” from the Menu bar 
 

Figure: The “Align” tool selected 

 
 

4.) Click on the Head bone (named “Head”). The Align Selected dialogue will appear. 
Check the boxes next to the X, Y, and Z Positions and choose the “Pivot Point” 
radio buttons seen below. 

 

Figure: Align Selection dialogue box 
 

 
 
 
 

Creating and Exporting Characters for 6 Reallusion, Inc. 
 

 iClone Page 16  Copyright © 200



Figure: The Hair pivot aligned to the Head bone. 
 

 
 

5.) Preapre a hair material named “Hair” and apply it to the hair mesh. Plrase refer to 
“Part 3: Character Texturing for iClone” for more material setting details. 
 

6.) Add the skin modifier to the hair mesh. Use "Head" bone for rigid hair. If a “soft” 
hair is desired, include "Neck", "LCollar", "RCollar", even "UpperTorso" bones 
in the bone list. Please refer to “Part 4: Character Skinning for iClone” for 
more skinning details.   

Figure: Skin modifier added to the hair mesh. 
 

 
 
Here’s a step-by step example of how to safely edit the template models. 
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NOTE: This tutorial is not meant to be the definitive process for editing the 
iClone template. This is only one of the ways to edit the template and uses this 
opportunity to explore a different technique in edit poly called paint deformation. 
You are encouraged to explore any method that you are comfortable with. 
 

These are the options for editing the character template: 
1.) Attempt to edit the parts individually 

a. Pros:  
i. Border vertices and edges are maintained 

ii. Depending on the amount of editing, the bone placement 
will be nearly correct (though some editing will be required) 

b. Cons: 
i. Reskinning is most likely required, especially if the mesh is 

changed 
ii. A lot of care must be given to maintain the borders between 

the body parts 
2.) Attach the parts and edit them as one 

a. Pros: 
i. It may be easier to work with a single mesh for polyediting 

b. Cons: 
i. You will need to recreate the border attachments 

ii. You will definitely need to reskin 
Let’s begin. 
 

1.) Open the 3DSMax file full_template_male.max. We will use this as our base 
geometry to complete some very heavy editing. 
 

Note: In the following steps, we only use a G1 character as an example for describing 
the concepts and principles. G2 characters use the same ideas, too. 
 

Figure: the full_male_template.max 
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  G1 G2

 
 
2.) Next we need to hide the un-necessary objects. These are: 
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a. The Character 01 node 
b. The RL Bones System 

3.) Select the Character node and the bones systems by hitting the “H” key on the 
keyboard. The Select by Name Dialogue appears. 

 
Figure: The Select by name menu with object selected 
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4.) Once the objects are selected, right click in the view port and choose “Hide 

Selection” from the Quad menu 
 

Figure: The Quad Menu. 
 

 
 

5.) Next we need to combine the objects into one. This one step has several sub-steps: 
a. Select the “Upper” object 
b. Delete “Mesh Select” and “Skin” and skin modifiers 

 
Figure: Delete these modifiers 
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c. Click on the “Attach by List” button on the modify command panel.  
 

Figure: The Attach by List button 
 

 
 

d. The Select menu appears so choose the “Lower” object and the “Shoes” 
object   

Figure: The Select by name dialogue 
 

 
 
This step will also delete the mesh select and the skin modifiers for the 
“Lower” and “Shoes” object. 
 
e. Finally, we need to weld the open borders created when we attached all 

the objects together. To do this we do the following: 
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i. Enter vertex sub object mode 
ii. Select all the vertices of the object 

iii. Choose “Weld” from the Modify command panel 
 

Figure: The welding of vertices 
 

 
 

We are now ready to actually edit the object. This part of the tutorial is completely 
subjective. You can edit your object anyway you like. This character was created to 
highlight a technique that keeps the original mesh fairly intact (especially the borders 
areas we will be recreating.) 
 
Feel free to use any technique you wish, but just keep in mind this character is a Standard 
Character, which means it will have special border requirements where the various pieces 
of geometry meet. (See “Vertex and Edge Border Rules” above) 

 
Here is the completed character. This is where we are headed. 
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Figure: Completed model, untextured, from tutorial video 
 

 
 
The strategy for this character is to: 

• Maintain the vertex border geometry. 
• Use editing tools that allow me to have great control over the existing 

polygons. 
• Use destructive editing as sparingly as possible. 
 

 
Edit the object.  
 
To see this process please refer to the tutorial video supplied with this chapter. 
 
Now that the character is complete, we must separate the major body parts into the 
separate objects that iClone needs for importing. 
 
1.) Using the marquee selection tool (or any other select tool you are comfortable with), 

select all of the geometry that will become the “Upper” torso object. 
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Figure: The Upper polys selected 
 

 
 
2.) From the Modify command panel, click the “Detach” button 

 
Figure: The Upper polys selected 

 

 
 
3.) Name the object “Upper” 
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Figure: The Detach and Name dialogue 
 

 
 

4.) Repeat the same steps for the “Shoes” object, just remember to name them “Shoes” 
 

Figure: The Shoes polys selected 
 

 
 

5.) Rename the remaining object (the legs geometry) “Lower” 
 
6.) Reskin the model at this point. Please refer below to Part 4: Character Skinning in 

iClone for this information. 
 
7.) With the objects all separated, renamed, and skinned its time to set up the sub object 

border attachments. Before we get into the step-by-step procedure, please review the 
diagram below that shows the setup of the sub object selections and their names. For 
this example we will be reverting to the original Male template. 
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Figure: Keep in mind the border attachments 
 

 

G1 

G2 
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Again remember, the border vertices must adhere to the vertex and edge count 
requirements mentioned previously. 
 
For each of the different objects (Upper, Lower, and Shoes) the modifier stacks will look 
like this: 
 

Figure: The Modifier stack must look like this as the end of the process. 
 

 
 
NOTE: The “MESH SELECT” modifier MUST be above the Skin modifier in order for 
iClone to properly identify the vertex borders. 
 
Beginning with the “Upper” object in the neck area. Do the following: 
 

1.) Add the “Mesh Select” modifier. 
 

Figure: Add the “Mesh Select” modifier 
 

 
 
2.) In Vertex sub-object  mode, Select the Vertices along the neckline. 
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Figure: The Neck Vertices are selected 
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 G1

G2 

 
 

 
 
3.) Create a Selection Set for these vertices by clicking in the “Selection Set” name 

field on the Menu bar and entering the name exactly (including case): Connect01 
 
 

Figure: The Selection Set Name field in on the Menu bar. 
 

 
 
NOTE: you MUST hit the Enter key for this name to take effect. Forgetting to this for 
all of the connections will require them to be redone (individually). 
 



4.) Now select the vertices along the bottom border of the “Upper” object in the waist 
area. 

 
Figure: The Waist Vertices are selected 
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 G1

G2 

 
5.) In the “Selection Set” name field name these vertices exactly (including case): 

Connect02 
 
6.) Once those are complete, we do the same thing with “Lower”. Add the “Mesh 

Select” modifier 
 



 
7.) Select the border vertices across the top (waist area) of the “Lower” object. 
 

Figure: The Waist Vertices are selected (on the “Lower” object) 
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 G1

G2 

 
 
8.) Just like Steps 3 & 5, name this Selection Set exactly: Connect02 
 
9.) Now the Ankles. Select the LEFT ANKLE and name the selection set for these 

vertices Connect03. 
 



 
10.) For the RIGHT ANKLE, name these vertices Connect04 
 

Figure: The Ankle Vertices are selected (on the “Lower” object) 
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 G1

G2 

 
11.) At this point, the same process is followed for the “Shoes” object. Add the 

Mesh Select Modifier.  
 
12.) Select the border vertices for the LEFT ANKLE and name it Connect03.  

 
 
13.) Select the border vertices for RIGHT ANKLE and name them Connect04. 



Figure: The Shoe Vertices are selected 
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 G1

G2 

 
14.) (For modeling the G2 characters, please read the following steps. Skip this part 

for G1 characters.) Now the Hands. Select the border vertices of the LEFT 
WRIST of the “upper” object, and name the selection set for these vertices 
Connect05. 
 

15.) For the RIGHT WRIST, select the border vertices of the “upper” object and 
name the selection set Connect06. 
 

16.) Finally, the same process is followed for the “Hands” object. Add the Mesh 
Select Modifier. 
 

17.) Select the border vertices for the LEFT WRIST and name it Connect05. 
 

18.) Select the border vertices for the RIGHT WRIST and name it Connect06. 
 



 
Right Hand Left Hand 

 

 
 
All the border connections are now complete. We are ready to Texture the object! The 
following tutorial covers the basic process for creating textures for iClone characters, not 
this character specifically, but you can see the textures created for this character at the 
end of this section. 
 
A Non-Standard Character 
 
A Non-standard character is a character that is comprised of a single mesh. The 
advantage of this is that you can quickly repurpose one of your existing models and use it 
almost immediately in iClone. The disadvantage is that this new character will not be 
able to exchange its parts with other body parts within iClone. If you don’t foresee 
needing to have interchangeable body parts within iClone consider the Non-Standard 
character type. 
 
In addition to interchangeable body parts, other disabled features include “Skin tone 
matching”, all “Head” functions, and “Facial Animation” 
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Part 3: Character Texturing for iClone 
 
NOTE: For this next section, we will use the “Adventurer” character that comes with 
iClone. 
 
Texturing in iClone is handled on a per object basis. Meaning you create the specific 
maps you need just for that object. Multi-Sub object materials are supported so you can 
have 2 materials per object. This is how you do skin and clothes at the same time. 
 
STOP! Before you begin texturing, you will need mapping coordinates for your geometry. 
UVW Mapping is not covered in this tutorial because this is considered a core skill to 
know for this chapter (see “Knowledge Needed” at the beginning of this section.) If you 
are unfamiliar with UVW mapping, please refer to the 3DS Max help to learn how. 
Particularly useful is the “Unwrap UVW” modifier.  
 
 

Figure: Step-by-step for the upper body 
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Here are examples of the Clothes map and the Skin Map used for the “Upper” object. 
 

Figure: The Upper Skin and Clothes maps 
 

  
Power-of-2 texture for Upper Clothed area Power-of-2 texture for Upper Skin area 

 
 
Here are the steps for the upper body in more detail: 
 

1. Create a skin material named “Skin”, set the diffuse color white (255, 255, 255). 
Using your favorite image-editing program, create a power-of-2 texture map that 
approximates what the skin of your character would look like without clothes. It 
isn’t necessary to create all the detail, just the detail that will be seen. Remember, 
a 10x10 pixel swatch from the skin map is used for the for the skin tone matching 
system. Be sure that this is present in the skin texturemap this this object (as well 
as the others). 
 

2. Create the Clothes Material named “Upper”, set the diffuse color white (255, 255, 
255). Again, using your favorite image-editing program, create a power-of-2 
texture map that represents the clothes your character will be wearing. 

3. Select the faces that are skin.  
a. Enter polygon (or face) Sub Object mode of the “Upper object” 
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Figure: Polygon Sub Object level 
 

 
 

b. Select the polys that will receive the skin material. 
 

Figure: Selected Polys 

 
 
 

4. Assign the material to the sub object selection 
a. Drag the “Skin” material from the material editor directly onto the 

selected polys. 
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Figure: The red arrow indicates where you drag the material from and where your drop it. 
 

 
 

b. DO NOT de-select the skin polys at this point. (see the following step) 
 

5. Select the polys that are the clothes 
a. With the skin faces still selected, go to the Edit menu and choose “Select 

Invert” 
 

Figure: Select Invert from the Edit menu 
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Figure: The inverted selection 
 

 
 

6. Assign the material to the new sub object selection.  
a. Drag the “Upper” material from the material editor 
 
Figure: The red arrow indicates where you drag the material from and where your drop it. 

 

 
 
TIP:  

1. You do not need to create a skin material if there is no skin visible. An 
example of this is a suit (like a space suit), or an alien. (But if the alien has a 
uniform over its skin, the same rules apply!) 

2. If you are modeling the G2 character, the hands object must be separately 
textured. Please go to the last section for more details.
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Figure: Step-by-step for the lower body 

 
Here are examples of the Clothes map and the Skin Map used for the “Lower” object. 

 
Figure: The Lower skin and clothes maps 

 

  
Power-of-2 texture for Lower Clothed area Power-of-2 texture for Lower Skin area 

 
 
The steps for the lower body are as follows: 
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1.) Create a skin material named “Skin” , set the diffuse color white (255, 255, 255). 
Using your favorite image-editing program, create a power-of-2 texture map that 
approximates what the skin of your character would look like without clothes. It 
isn’t necessary to create all the detail, just the detail that will be seen. Remember, 
a 10x10 pixel swatch from the skin map is used for the for the skin tone matching 
system. Be sure that this is present in the skin texturemap this this object (as well 
as the others). 
 

2.) Create the Clothes Material named “Lower” , set the diffuse color white (255, 255, 
255). Again, using your favorite image-editing program, create a power-of-2 
texture map that represents the clothes your character will be wearing. 

 
TIP: Remember, you can use the same texture map as the upper object. 
 

3.) Select the faces that are skin. Enter polygon (or face) Sub Object mode of the 
“Lower object” 

 
 

Figure: Polygon Sub object selection 
 

 
 

7.) Select the polys that will receive the skin material. 
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Figure: Selected Polys 

 

 
 

8.) Assign the material to the sub object selection. Drag the “Skin” material from the 
material editor directly onto the selected polys. 

 
Figure: The red arrow indicates where you drag the material from and where your drop it. 
 

 
 

DO NOT de-select the polys faces at this point. (see the following step) 
9.) Select the polys that are the clothes. 
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10.) With the skin polys still selected, go to the Edit menu and choose “Select 

Invert” 
Figure: Select Invert from the Edit Menu 

 

 
 

Figure: Inverted Selection. 
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11.) Assign the material to the new sub object selection. Drag the “Lower” 

material from the material editor 
 

Figure: Drag material to newly selected polys. 
 

 
 
 
Figure: Step-by-step for the shoes 

 
 

Here are examples of the Shoes map and the Skin Map used for the “Shoes” object. 
 

Cr
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Figure: Shoes map 
 

 

None for this Character 

Power-of-2 texture for Shoes Power-of-2 texture for Shoes Skin area 
 
 
The steps for the shoes follow: 
 

 
1.) Since there is no Skin area for the shoes, we merely need to add the Shoe material 

to the boots. Create the Shoe Material named “Shoes”, set the diffuse color white 
(255, 255, 255). Again, using your favorite image-editing program, create a 
power-of-2 texture map that represents the shoes your character will be wearing. 

 
2.) Select the object or faces that are the shoes 

 
3.) Assign the material to the new sub object selection.  

 
4.) Drag the “Shoes” material from the material editor 

 
Note: If there are skin areas on the “Shoes” object (ex. sandals), prepare and assign the 
“Skin” material as described in the “Upper” and “Lower” sessions above. 
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Figure: Drag material to newly selected faces. 
 

 
 

The next section describes the steps to assign textures to the hands. Remember that the 
“Hands” body part is only created for the G2 characters. If you are using the G1 
characters, please skip this paragraph and go on to Part 4. 

Figure: Step-by-step for the lower body  

 
 
The steps for the hands are as the following: 

1.) Create a skin material named “Skin”, set the diffuse color white (255, 255, 255). 
Using your favorite image-editing program, create a power-of-2 texture map that 
approximates what the skin of your character would look like without clothes. It 
isn’t necessary to create all the detail, just the detail that will be seen. Remember, 
a 10x10 pixel swatch from the skin map is used for the for the skin tone matching 
system. Be sure that this is present in the skin texturemap this this object (as well 
as the others). 
 
Note: Please notice that the “Hands” and “Upper” may share the same skin 
texture. However, this is not a requirement. “Hands” may also use a separate 
skin texture. 
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2.) Select the polygons that are “skin”. Enter polygon (or face) Sub Object mode of 
the “Hands object”. 

3.) Select the polys that will receive the skin material. 
4.) Drag the “Skin” material from the material editor. 
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Once you have completed the texture creation process, you now have a character that is 
ready for iClone. 
 

Figure: This Finished Character 
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Part 4:Character Skinning for iClone 
 
In this section we’ll cover the basic steps to prepare the mesh you’ve created or edited for 
export to iClone. This is the stage where you use 3dsMax’s skinning modifier to allow 
the RL Bone system to control your mesh once it gets exported to iClone. 
NOTE: For the purposes of this chapter (learning how to skin a mesh) we will be using a 
single mesh for brevity. Keep in mind that you will need to skin each object separately 
before exporting to iClone (Upper, Lower, Shoes) using the methods explained here. 
 
Skinning Strategies: 
 
There are many different ways to skin a mesh (!). Pun aside, it is true. The method 
presented here is just one method. Feel free to use any method you have experience with. 
Consider this method a guidepost for getting started. 
 
Iterative process: Skinning any mesh is an iterative process. There is a great deal of edit 
and adjustment that takes place throughout the process. Don’t expect to get it perfect the 
first time, especially if you are new to skinning. Do expect to go back and fourth between 
iClone and 3DSMax a couple of times at least as you perfect the skin envelopes in 
3DSMax. 
 
Anatomy reference and placement: Get some anatomy reference. Bones are meant to 
control the skinned meshes, but only as good as we position them under the mesh. 
Making sure bones are centered within the mesh and scaled to mimic real bones, though 
logical, is not the correct method.  
 
Concentrate on accurate pivot placement first: Accurate pivot placement is initially more 
important than bone scale. Vertex control is dependant on bone’s scale beneath them. The 
closer the volume of the bone is to the mesh, the more accurate the control is, but proper 
pivot placement is what makes any movement look real. 
The principle for G2 characters skinning is the same as G1 characters, only the bones are 
more complicated. 



Figures: Top—the proper placement of pivots. Bottom—the proper scale of bones. 
 

  
Logical, but not correct pivot position Anatomically correct pivot placement 

 
 
 

 
 
Work from the Pelvis outward. It’s tempting to start with the arms or the hands, but this is 
last place you should start. All humanoid movement emanates from our center of gravity-
- which is the pelvis-- so start there and work outward.  
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So lets look at one method for this process.  
 
Figure: Step-by-step for positioning bones. 
 

 
 
Here are the steps in more detail. 
 
Get your Mesh and RL-Bones in the same max file. 
 

1.) Open the 3DS Max File  “RL_Bones_only.MAX”. This file contains the 
RL bone system. 

 
Figure: The RL_Bones_only.max file 
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2.) Merge your model into this scene (File Menu>Merge).  
 

Figure: Merge from the File menu 
 

 
 
Begin with the pelvis: 

 
3.) Scale and reposition (if necessary) your character mesh to match the RL 

Bone position. Use the face reference model as the reference point for 
your model. In other words, match your model’s face to the same position 
as the RL Bones reference face. (Keep in mind you will also be 
positioning your bone structure’s center of gravity in the pelvis area. 
Keeping the face position reference is a good starting point of reference as 
you go. But after this step, pivot placement takes priority.) 

 
Figure: The Custom mesh merged, positioned and scaled. 
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4.) Now position the LowerTorso object (which is the pelvis’ center of 
gravity or ‘COG’) in the appropriate position in the mesh. Position it from 
the front view first and then any side view second. 

 
Figure: The COG Placement from the Front and Side views 

 

 
 

5.) Now from the front view, select both pelvis bones and scale them to place 
the pivot point of the hip socket appropriately. 

 
Figure: Note the placement of the hip pivot points. 
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6.) Now scale the pelvis from the side view to approximate the volume of the 
lower torso. It’s OK if the bones protrude from the mesh. 
 

Figure: Note the scale of the pelvis volume. 
 

 
 
The legs are next… 

 
7.) Now that hip pivots are placed, let’s work down the legs first. Select both 

thighbones at the same time and position the knee pivots from a SIDE 
view by using the rotate transform with the “use Pivot Point Center” pivot 
setting. You may need to rotate and scale to place the knee pivots properly. 
Doing both bones at the same time will ensure symmetry from the view. 

 
Figure: Be sure to use the Local Reference Coordinate System and the ‘Use Pivot Point Center’ setting. 
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Figure: Note the KNEE pivot placement (Lower red line). 
 

 
 
8.) Next from the FRONT view, rotate each thigh bone individually to 

position the inside the mesh. 
 

Figure: Note the KNEE pivot placement and Bone Scale. 
 

 
 

9.) Next, scale the volume of the thigh bones to closely match the volume of 
the leg. It’s OK if the bones protrude from the mesh. Remember, pivot 
placement is more important than bone volume. (see Figure above) 
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10.) Repeat the same process for the lower legs next. Begin with a 
SIDE view, select both lower leg bones, and rotate (locally) to position the 
ankle pivot point. 

 
 

Figure: Note the ANKLE pivot placement and Bone Scale. 
 

 
 
11.) Then from the FRONT, rotate the ankle pivots to their appropriate 

positions and scale. 
 

Figure: Note the ANKLE pivot placement and Bone Scale. 
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12.) Finally, scale the foot bones individually. Be sure to have the last 
bone (the toes) protruding from the tip of the mesh. 

 
Figure: Note the FOOT bone scale. 

 

 
 

Now the spine… 
13.) Now that the lower body is roughly in place, let’s start the upper 

body. Begin by rotating the spine parts into place from the SIDE view. 
Again, the important thing here is paying attention to the placement of the 
pivot points. Additionally, anatomical reference is crucial here. Note the 
spine is actually located near the back of the upper body volume, not the 
center. 

 
Figure: Note the Spine is towards the ‘back’ of the mesh  

and notice the red lines try to mimic the contour of the spine 
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14.) Now from the SIDE and FRONT, scale the spine bones as best a 
possible to match the volume. 

 
Figure: Positioned and scaled spine  

 

 
 

15.) Repeat and adjust as necessary. 
 
16.) The clavicle placement is really about where the shoulder pivots 

are located. Again, anatomical reference here is crucial. This step is also 
done on each clavicle individually. But try to be as symmetrical as 
possible. The clavicles are rotated and scaled into place from the FRONT 
view and double checked in any other view. 

 
Figure: Note the shoulder pivots; they are not in the center of the mesh. Anatomy reference is crucial.  
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Finally, the arms and hands… 
17.) With the clavicles (shoulder pivots) in place, now we can 

concentrate on the arms and hands. From the FRONT view, begin by 
rotating the upper arms to match the relative position of the arms. In this 
step we are attempting to position the elbow pivots. This can be done 
simultaneously on both left and right bones by using the local ref 
coordinate systems and local pivots. (see “Legs”, Step #1) 

18.) Next, from the TOP view, position the elbow pivots in their proper 
location. This is done by using rotate or scale as needed 

19.) From any viewport you can scale the volume of the bone to closely 
match the volume of the mesh. 

 
Figure: Elbow Pivot Placement. (The bones have also been scaled)  

 

 
 

20.) Now come the forearm and placement of the wrist pivot. Using the 
same method as the upper arm bones, use scale and rotate from either the 
TOP or FRONT viewport. 
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Figure: Wrist Pivot Placement. (The bones have also been scaled)  
 

 
 

21.) Finally, the hands. These are potentially the most tedious and time-
consuming part of the boning and skinning process. The good news is that 
by now you have all the skills and knowledge needed to place each pivot 
point within the mesh and scale the bone appropriately. Use the TOP or 
SIDE or PERSPECITVE viewports as needed to rotate and scale the bones 
into position for each finger. Remember to use the local reference 
coordinate system. 

 
Figure: Hands are boned, notice bones coming through tips of fingers.  
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Add the Skin Modifier… 
 
Adding the skin modifier is the next step in the process. For this stage, it’s important to 
remember that, for the Standard iClone character, the Skin modifier is added to each 
major body object (Upper, Lower, Shoes, Hands) individually. For a Non-Standard 
character it’s added to the entire mesh, so there is only one skin modifier. 
 
The process of adding the bones is the same for each of the meshes. So for the sake of 
brevity, we will only show the example for the upper body object here.  
 

1.) Select the mesh and from the modifier drop down menu choose the skin modifier 
 

Figure: Get the Skin modifier from the Modifier drop down menu 
 

 
 

2.) Next, in the modifier, choose the “Add” button to add the bones. A selection list 
appears and this is where you choose the bones. 

 
STOP! Be sure you do NOT choose the “[Character01]” node—if it is present. Although 
this is part of the hierarchy; it is not part of the bone structure. 
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Figure: Click to add the bones to the Skin Modifier 
 

 
 
 

3.) Select everything from “Upper torso” downward AND the “LowerTorso” object 
AND the L_Abdominal and R_Abdominal. Use the same steps for all the other 
body parts, except just select the relevant bones for those objects. 

 
Figure: The bones added to the Skin Modifier 
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TIP: What about those abdominal bones? L_Abdominal and R_Abdominal are two 
bones specifically used for controlling the scale of the belly in iClone. Be sure to 
include these bones for making your character skinny or fat when you adjust the 
proportions in iClone. 
 

Editing the Skin modifier 
 
Editing of the modifier is required because inevitably, the control the bones assert over 
the vertices is not what you intended. So to editing is in order. In the figure below you 
can see just one of numerous possible examples how vertices are inappropriately 
weighted and must be corrected. 
 

Figure: An example of incorrect vertex weighting 
 

 
 
This stage is arguably the most challenging. First, regardless of what we show in this 
tutorial, your experience will be completely different from what is shown here. That is 
because the modifier’s effectiveness is based on the all the pivot placement and bones 
scaling we completed in the previous steps. So consider using the following steps a 
general guide for your editing experience and not a precise roadmap. Second, because of 
this fact, only a small portion of the entire process is covered in the following steps. Take 
what you learn in the follow steps and apply them to the entire process of envelope 
editing each bone.  
 
Control of the mesh is determined by proper bone pivot placement along with bone 
scaling with appropriate vertex weighting (the amount of influence each bone has over 
the vertices assigned to them). 
 
In this stage, editing the envelopes is about adjusting the weight of the vertex 
assignments to the bones. 
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To edit the envelopes: 
1.) Select the “Upper” mesh and then select the “skin” modifier from the Modifier 

Stack.  
2.) Enter “Envelope” Sub object level. 

 
Figure: Edit Envelope Sub Object Mode 

 

 
 
3.) You will notice in the viewport that there are small black lines done the center of 

each bone. These are the bones at the sub-object level. 
 

Figure: Sub Object Bone selected from Edit Envelopes 
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NOTE: At this point, you may want to HIDE the bones to make things easier to see. 
You will have to UNHIDE them when you are ready to move them to test your 
skinning. 
 
4.) Select the left upper arm bone (LUpArm) 
5.) In the viewport you will see colored vertices or shaded faces. Then color 

variations indicate the amount of influence (weighting) the underlying bone has 
on these vertices 

Figure: Envelopes active on the selected bone. 
 

 
 
6.) Adjust the size of the envelopes by clicking and dragging on the boxes at either 

end of the oval shape. This will scale the envelope and there-by increase or reduce 
its influence over the nearby vertices. 

 
Figure: Envelope handles are highlighted in the figure below. 
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7.) In the following example you will notice some vertices that appear to be 

controlled by a different envelope. By adjusting the scale of the envelope (and 
neighboring envelopes, you can bring those vertices under control. 

 
Figure: Left thigh vertices are not controlled properly. 
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Figure: Through envelope adjustment, left thigh vertex control is improved. 
 

 
 
 
There are many more areas to explore in the skinning process, more than we can 
effectively cover here. So for more information about Skin, please refer to the 
3dsmax help file.    

 
The fact is that skinning, and editing envelopes is a process that requires trail and error to 
gain experience. For this reason we a somewhat limited in the depth we can cover here. 
There are many other settings and tools in the Skin modifier that can aid in this process, 
but far too many to effectively cover here. 
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Part 5: Exporting 
 
Now that everything is complete, we are ready to export the model to iClone. The process 
for exporting Standard and Non-Standard Characters are basically the same with a couple 
small differences. 
 
Here are the steps to export a Character 
 
To export the data and load it in iClone, do the following: 
 

1.) Save your Max file (CTRL-S, or File Menu) 
 
2.) Render the Scene. Important: Rendering the scene is REQUIRED prior to 

exporting to make sure the texture information is embedded in the exported file.  
 

 
3.) From the File Menu, choose “Export” 
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4.) Change the file type to “.VNS” the iClone file format.  

 
Figure: The “.VNS file format selected. 

 

 
 
 
5.) Direct the file to the specific directory: 
The paths for “Template” directory are: 
\Program Files\Reallusion\iClone\Template\Character (iClone 1.X) 
\Program Files\Reallusion\iClone 2\Template\iClone Template\Character (iClone 2.X) 

 
OR 
 
The paths for “Custom” directory are: 
      \Documents and Settings\AllUsers.WINNT\Documents\Reallusion\Custom\iClone  
Custom\Character (iClone 1.X) 
……\Documents and Settings\All Users\Documents\Reallusion\Custom\iClone 2 
Custom\Character (iClone 2.X) 
 
Note: If you changed your default Template or Custom folder location during installation 
then use the path you used at that time. 
 
 

6.) Once you click the “Save” button, the iClone export dialogue will appear (see 
below). Check the box that says “Character” or “Non-Standard” Character. The 
personal information is optional.  
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Figure: The iClone exporter dialogue box  
 

 
 
6.)  The other checkboxes are relevant to the specifics of your project (such as texture 
limitations). For more information on the specifics of those settings, please refer to 
"Export for iClone" session. 

 
 
Now import the data into iClone: 
 

1.) Open iClone. 
2.) Click on the “Avatar” icon at the top of the interface 
 

Figure: “Avatar” Icon 
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3.) Click on the “Character” tab. (See Figure below) 
 
4.) On the right side of the screen, click on the “Modify” tab to bring up the 

Adjustment panel. (See Figure below) 
 
5.) Click on the Folder Icon to bring up the load scene dialog. 
 

Figure: Steps 3, 4 and 5. Click here to import the scene you exported from 3DS max. 
 

 
 
 
There! You have now successfully loaded your Character created or modified in 3DS 

Max into iClone. 註解 [S1]:  
頁: 7 
We can tell developers how to 
“Add” 3d scene to “Custom” 
asset here. 

註解 [CM2]: Spock, is this 
meant for me or for someone 
else? 
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IV. Checklist 
 
 
Here is the checklist—in order-- that covers the character creation process 
 

 Create a new character or modify and existing character 
 
Standard Character checklist 

 There are five G1 character body parts and six G2 character properly named body 
parts 

 The body part connections are set properly at the vertex level 
 The connection points have the required numbers of edges and vertices 
 The pivot points are aligned to the proper bones 

 
Non-Standard Character checklist 

 Create or modify your mesh 
 Suggested polygon limit is 15,000 

 
Texture checklist 

 Create power-of-2 texture maps for each objects of the Standard Character 
 

 Apply the textures to the appropriate sub object polygons (Upper, Lower, Shoes, 
etc…) 

 Make sure the Skin texture has a 10x10 pixel averaged skin color in the upper left 
corner for automatic skin tone matching 

 
Skinning checklist 

 Position RL Bones at 0,0,0 
 Position your mesh(es) roughly in line with the RL Bones 
 Fit the bones within your mesh by placing pivot points and scaling the bones 
 Add the Skin Modifier 
 Edit/adjust envelopes and vertex weights as needed 

 

V. References to 3DS Max 
 
Looking for more information on where to look in 3DS Max for the concepts mentioned 
here? Open up the max help file and search for the following terms for more information. 
 

• Pivot points 
• Edit Poly/Edit Mesh 
• Groups 
• Selection Sets (at the Sub object level) 
• UVW Mapping 
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• Unwrap UVW modifier 
• Sub Object Mode 
• Transforms 
• Material Editing 
• Applying materials at the sub-object level 
• Skin modifier 
• Vertex weighting 
• Envelopes 
• Hierarchies 
• Inverse Kinematics 
 
 

 

VI. Anatomy Reference bibliography 
 
Atlas of Human Anatomy, Third Edition, by Frank H. Netter, John T. Hansen,  
ISBN: 1929007116   
 
 
An Atlas of Anatomy for Artists, Fritz Schider, Bernard Wolf (Translator), 1972,  
ISBN: 0486202410 
 
Character model in Blue Shirt courtesy of www.axyz-design.com 
 
About the Author: Chris Murray wrote this section. Chris is a nationally recognized instructor and author 
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available for production based training on 3DS Max and other 3D apps. His website is 
www.cme3d.com/training 
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